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One-Week Module on Stochastic Groundwater Modeling 

INTRODUCTION 
Students of groundwater hydrology enjoy several 

benefits from an introduction to groundwater modeling 
software, such as MODFLOW (Harbaugh and McDonald, 
1996). From a practical perspective, students gain a skill 
that is useful in consulting practice. From an educational 
perspective, students gain insight into the geometry and 
dynamics of groundwater flow, since results are presented 
visually. In addition, learning groundwater modeling 
provides an opportunity to develop higher-level cognitive 
skills, as students critically evaluate their model in terms 
of its conceptual basis, assumptions, and intended use. 
These cognitive skills allow students to appreciate the well
-known notion that ―all models are wrong but some are 
useful‖ (Box, 1979). 

Perhaps the most important assumption in elementary 
groundwater models is that of homogeneous hydraulic 
conductivity. This assumption is a major simplification, 
meaning that predictions of production rates, power 
requirements, and water quality may suffer from major 
errors. Deterministic models lack the ability to quantify 
these errors. Stochastic groundwater models, in contrast, 
allow the modeler to calculate the uncertainty of model 
results, most commonly by modeling the heterogeneous 
hydraulic conductivity as a spatially-correlated random 
variable. In academic research, stochastic groundwater 
modeling is a standard approach, dating back to the 1970s 
(Freeze, 1975), for which standard textbooks are available 
(Rubin, 2003; Zhang, 2002). However, stochastic 
groundwater models are not widely used in consulting 
practice (Schwartz and Ibaraki, 2001), and several 
explanations have been proposed (e.g., Pappenberger and 
Beven, 2006; Zhang and Zhang, 2004). One explanation is 
the lack of information to quantify the heterogeneity of 
typical aquifers; this concern has been partially addressed 
by a published summary of the mean, standard deviation, 
and spatial correlation length of hydraulic conductivity at 
numerous sites (Tables 10.7 and 10.8 in Rubin et al., 1999), 

and by the World Wide Hydrogeological Parameters 
Database at wwhypda.org (Comunian and Renard, 2009). 
A second explanation is a lack of software to implement 
stochastic groundwater models; this concern has been 
partially addressed by MODFLOW-STO (Liu et al., 2006). A 
third explanation is that while stochastic groundwater 
modeling is standard in academic research, it is not yet 
standard in groundwater education (Neuman, 2004; 
Renard, 2007; Winter, 2004). The objective of this article is 
to partially address this third explanation. 

Li and Liu (2004) present a compelling argument for 
the need for a constructive approach when teaching 
groundwater hydrology, in which students first learn 
specific concepts, then integrate them into a general 
understanding. Since then, several constructive methods 
for teaching groundwater have appeared in the geoscience 
education literature. Neupauer (2008) presents a semester-
long containment design project that integrates various 
groundwater topics. Neupauer and Dennis (Neupauer 
and Dennis, 2010) describe an in-class demonstration that 
allows students to discover Darcy’s law. All of these 
studies are based on the premise that active learning—in 
which students manipulate physical objects, build 
computer models, or participate in classroom 
discussions—can be more effective than traditional 
lecturing (e.g., Light, 2001; Lowman, 1995). However, 
articles on active learning methodology for stochastic 
groundwater modeling appear to be absent from the 
geoscience education literature.  

This article describes a one-week introduction to 
stochastic groundwater modeling, intended for the end of 
a first course on groundwater hydrology, or the beginning 
of a second course on stochastic hydrogeology or 
groundwater modeling. This brief module is not intended 
to create expert stochastic modelers. Instead, the goal is 
for students to learn the qualitative concepts of stochastic 
groundwater modeling through a guided computer 
exercise, in order to gain insight into the limitations 
inherent in deterministic groundwater models. The 
educational objectives for this one-week module are listed 
in Table 1. Each objective begins with a verb, indicating an 
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ABSTRACT 
This article describes a one-week introduction to stochastic groundwater modeling, intended for the end of a first course 
on groundwater hydrology, or the beginning of a second course on stochastic hydrogeology or groundwater modeling. 
The motivation for this work is to strengthen groundwater education, which has been identified among the factors 
contributing to the lack of stochastic groundwater modeling in professional consulting practice. The educational 
objectives are for students to (1) define key terminology, (2) explain spatial correlation, (3) produce realizations of 
groundwater flow, and (4) critique deterministic groundwater models. This one-week module includes a reading 
assignment, a class presentation, a guided computer exercise, and a homework assignment. The module introduces 
students to a few basic terms and concepts, then gives them experience through hands-on computer exercises. This 
article includes a detailed lesson plan and homework assignment, and complete model inputs and solutions are 
provided. The guided computer exercise and the homework assignment are performed using the freely available 
software Processing Modflow for Windows (PMWIN). Submitted homework assignments demonstrate that students were 
able to transfer skills from the module to a new application, and through an assessment survey, students reported 
significant improvement in their ability to perform three of the four educational objectives.  
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action that the student should be able to perform after 
completing the assigned reading, attending class, and 
finishing the homework assignment. The objectives are 
intended to cover the spectrum from basic to advanced 
cognitive skills described by Bloom’s taxonomy (Lowman, 
1995). Because each objective is a specific action, it can be 
assessed through a homework assignment, quiz, or exam.  

 

LESSON PLAN 
This module includes a reading assignment, a 75-

minute classroom presentation, a 75-minute guided 
computer exercise, and a homework assignment. This 
module could also be presented as a 50-minute classroom 
presentation, a 25-minute classroom presentation followed 
by a 25-minute computer demonstration on generating 
spatially correlated random patterns of hydraulic 
conductivity, and then a 50-minute guided computer 
exercise on stochastic groundwater modeling. Since 2006, 
this module has been presented during week 14 of a first 
course on groundwater hydrology that previously covers 
aquifer hydraulics (weeks 1-8), well hydraulics (weeks 9-
10), and contaminant transport (weeks 11-13). 

This lesson plan employs the software Processing 
Modflow for Windows (PMWIN), which provides a 
graphical user interface for the standard groundwater 
modeling software MODFLOW. PMWIN 5.3 is available for 
free download from ETH Zurich (2009) or pmwin.net 
(Chiang, 2006), and is also available on the CD-ROM that 
accompanies Chiang and Kinzelbach (2001) or Chiang 
(2005). Earlier in the semester, the class meets in a campus 
computer laboratory in order to run through the PMWIN 
tutorial step-by-step, which appears as Chapter 2 in the 
online manual by Chiang and Kinzelbach (1998) or Section 
4.1 in the monograph by Chiang (2005). Then, after 
completing the tutorial, students complete two PMWIN-
based homework assignments, so by week 14 they have 
some experience with PMWIN. Although the details 
presented below are specific to PMWIN, the educational 
objectives are not, and could be accomplished through 
any groundwater modeling software that includes a 
graphical user interface and the ability to generate several 
spatially-correlated random patterns of hydraulic 
conductivity, such as Interactive Groundwater (Li and 
Liu, 2004).  
 
Reading Assignment 

For the module on stochastic groundwater modeling, 
the assigned reading includes two components. First, 
students read Section 5.3 in Chiang and Kinzelbach (1998), 
corresponding to Section 2.7.3 in Chiang (2005), which 
explains how the Field Generator generates spatially 

correlated random fields. Second, students read Section 
6.7.2 in Chiang and Kinzelbach (1998), corresponding to 
Section 5.6.2 in Chiang (2005), which presents a stochastic 
modeling example that is similar to the guided computer 
exercise described below. 
 
Classroom Presentation 

The goal of the classroom presentation is to introduce 
the terminology, key concepts, and modeling approach 
that will be used in the subsequent class meeting in the 
computer laboratory. The remainder of this section is 
presented as a lesson plan that can be directly presented to 
students. 
 
Terminology - The instructor can start by writing ―One 
Step Toward Reality‖ on the board, which serves as a title 
for this lesson. Remind students about the standard 
assumptions used in groundwater models, both analytical 
and numerical, viz the aquifer is homogeneous, isotropic, 
arbitrarily large, and has a flat impermeable base. Define 
the term deterministic to identify such a model, containing 
neither randomness nor unknowns. Contrast this with the 
definition of stochastic, which includes randomness or 
unknowns. The one step toward reality is to adopt a 
stochastic model of the hydraulic conductivity, while 
leaving other variables—such as porosity, dispersion 
coefficients, sorption coefficients, boundary conditions—
as deterministic constants. Explicitly highlighting the fact 
that most of the model inputs are still deterministic 
emphasizes the important point that stochastic 
groundwater models, like deterministic models, still 
require simplifying assumptions. 
  
Key Concepts - This section introduces the concept of a 
space random variable, using an analogy to real estate 
prices, with part of the presentation performed by a 
student volunteer. Define the hydraulic conductivity, K, 
with three parameters, (a) the mean (b) the standard 
deviation sK, and (c) the spatial correlation length. For a 
numerical model with N grid blocks,  and sK are defined 
by 
 
         (1) 
 
and 
 
   
         (2) 
 
which can be implemented by the Microsoft Excel 
functions =average() and =stdev(), respectively. These two 
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TABLE 1. EDUCATIONAL OBJECTIVES FOR THE ONE-WEEK MODULE 
WITH THE CORRESPONDING COGNITIVE LEVEL  

1From Bloom’s taxonomy of educational objectives (Lowman, 1995) 

 

Objective Cognitive Level1 
Define stochastic, spatial correlation, stationary, and realization. 1 – Recall 
Explain spatial correlation in aquifers (or house prices). 2 – Comprehend 
Produce three stochastic realizations of groundwater flow. 3 – Apply 
Critique standard deterministic groundwater models. 6 – Evaluate 
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parameters are defined explicitly, because they will be 
familiar to most students. In contrast, the explicit 
definition of the spatial correlation length as an integral 
scale requires the concept of spatial covariance, which is 
not familiar to most students. Instead, spatial correlation 
is introduced by analogy to real estate prices, a concept 
that most students intuitively understand. Using an 
analogy allows the instructor to introduce the new 
concept in a familiar context, and then to transfer the new 
concept to the intended application (Liu, 2004). 

The real estate analogy for spatial correlation is as 
follows: The median sale price of a residential property in 
Denver during the 4th quarter of 2005 was approximately 
$225K, with an assumed minimum of $50K and maximum 
$10M. Instructors should adjust these figures as 
appropriate for their local municipality. Students 
generally understand that there is a certain degree of 
variability between the prices of neighboring houses, 
which is the concept of a space random variable. Now 
sketch a map of your local municipality, and randomly 
pick a $50K property. Ask a student to estimate the price 
of the house next door. The student will probably name a 
price below the median of $225K, and will probably not 
name a price near $10M. This is because students know 
that inexpensive houses are generally located in 
inexpensive neighborhoods, which is the concept of 
spatial correlation. Next, pick another property far away 
from the first $50K property, and ask a different student to 
predict its price. With a little prompting, the student will 
likely guess the median price of $225K. This is the concept 
of spatial correlation length, which indicates the distance 
over which spatial correlations persist. In housing the 
spatial correlation length might be three blocks. If that is 
true, then knowing that a certain property is within three 
blocks of the $50K house tells us that the property is 
probably inexpensive. On the other hand, knowing that a 
certain property is more than three blocks from the $50K 
house tells us nothing about its price, such that the best 
guess would be the median price. 

Having introduced the concepts of space random 
variables, spatial correlation, and spatial correlation 
length in the context of real estate prices, placing these 
concepts into the context of hydraulic conductivity is now 
fairly straightforward. This can be illustrated by drawing 
a 3x3 grid on the board and establishing a legend for sand 
(dots), silt (hatch), clay (crosshatch), and indicating a 
correlation length of one grid block. Fill in one cell with 
sand, then ask a student volunteer to come forward and 
populate the rest of the grid, one cell at a time. Remind the 
student that one is more likely to find sand or silt next to 
sand, and less likely to find clay. Getting the student 
involved will increase her or his comprehension, and the 
other students will be more likely to pay attention, since 
there is an element of drama when a student works at the 
board. 

Next, define the log hydraulic conductivity, or simply 
log conductivity, which is frequently used in stochastic 
groundwater models. Explain this by noting that 
hydraulic conductivity varies over orders of magnitude. 
This is analogous to the hydrogen ion concentration [H+] 
in chemistry, which also varies over orders of magnitude. 

In that case, the pH is defined as -log10[H+]. We perform a 
similar transformation to define log conductivity as 
Y = log10(K). So, for example, when K = 0.000010 m/s, then 
Y = ‑5.0 (m/s); when K = 0.0010 m/s, then Y = ‑3.0 (m/s), 
where the parentheses indicate the units of K from which 
Y was calculated. Point out that some authors use ln(K) 
rather than log10(K). Having defined Y, we can now define 
its mean  standard deviation sY, and correlation length 
IY. Point out that sY and IY do not depend on the units of K, 
unlike Y. In many aquifers, K is log normally distributed, 
which makes Y normally distributed. According to Rubin 
et al. (1999), for aquifers 100‑1000 m in size, a typical 
range of sY is 0.4-2.1, and a typical range of IY is 6-40 m. In 
contrast, it is useful to note the de facto assumptions used 
in deterministic models with homogeneous hydraulic 
conductivity, namely that  and either sY = 0 
with an arbitrary IY, or alternately sY is arbitrary with 
IY = . These de facto assumptions are clearly unrealistic. In 
the guided computer exercise and the homework 
assignment, we will assume sY = 1 and IY = 10 m, which 
are within the normal ranges reported by Rubin et al. 
(1999). 

One final concept is the definition of a stationary 
model. We are now assuming that K(x,y) and therefore Y
(x,y) are spatially-correlated random variables. If  sK, IK 
(or sY, IY) are all constants, then the stochastic model is 
stationary. This can be a difficult concept for students to 
grasp. Having just been introduced to the concept of space 
random variables, students are now asked to consider 
whether the parameters describing the spatial variability, 
namely  sK, IK   (or  sY, IY), are space random variables 
in their own right. Generally we assume the answer is no. 
Considering that the assumption of stationary random 
variables is a known limitation of many stochastic 
groundwater models, it is important to mention this 
definition. 
 
Modeling Approach - For global learners, before working 
through the details, it is useful to place new ideas into a 
larger framework. This framework is the Monte Carlo 
approach (Rubin, 2003), whose implementation is 
straightforward within PMWIN: (1) Create a MODFLOW 
model in the usual fashion. (2) Use a spatially-correlated 
random hydraulic conductivity field to populate each grid 
block with a different value. (3) Run MODFLOW to calculate 
the hydraulic head at each grid block. (4) Run the particle 
tracking subprogram PMPATH to examine pathlines 
visually. (5) Run a contaminant transport simulation, such 
as MT3D or MOC3D, to calculate the concentration of 
contaminants at each grid block. (6) Repeat steps 2-5 until 
the histogram of the output variable stabilizes, which 
could be production rate, power requirement, or water 
quality. Explaining step 2 requires two more definitions. 
This step creates a single realization, which is defined as 
one configuration of the hydraulic conductivity that is 
possible, but no more likely than another configuration. 
Furthermore, this is an unconditional realization, since 
there is no guarantee it will match the hydraulic 
conductivity measured at a specific point in the aquifer. 
The Monte Carlo approach is simple, but computationally 
intensive, since it generally takes hundreds or thousands 
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of realizations before the histogram of the output variable 
stabilizes. However, because time is limited in this one-
week module, students are not expected to produce full 
Monte Carlo simulations. Instead, students complete just a 
few realizations, which is sufficient to illustrate the crucial 
point that groundwater flow and transport includes a 
great deal of spatial variability and predictive uncertainty. 
  
Guided Computer Exercise 

The second 75-minute presentation takes place in a 
computer laboratory, in which each student has a 
individual computer pre-loaded with PMWIN, and the 
instructor’s computer is displayed on a projection screen 
at the front. Earlier in the semester, this facility was used 
to run through the PMWIN tutorial step-by-step. The 
specific exercise is based on Example 6.7 in Fitts (2002), 
which considers steady flow to an extraction well in a 
confined aquifer near a lake. Model units are meters and 
days. When homogeneous conditions are assumed, the 
transmissivity is specified as T = 20 m2/d, modeled as a 
single layer of thickness 20 m and a hydraulic 

conductivity of K=1.0 m/s. The extraction rate is 295m3/d. 
The exercise is simply to plot the streamlines from the lake 
to the well, first assuming homogeneity, and then 
assuming heterogeneity with sY = 1 and IY = 10 m. After 
completing the deterministic model, students find it very 
simple to run the stochastic model by resetting the 
hydraulic conductivity matrix and then running the 
model. Random field generation in PMWIN uses the 
subprogram Field Generator (Frenzel, 1995), which 
implements the algorithm of Mejía and Rodríguez-Iturbe 
(1974). Field Generator produces stationary realizations 
(constant  sY, IY) taken from a lognormal distribution. 
Field Generator output is repeatable for a given set of 
input specifications, such that all students should generate 
identical results, which facilitates homework grading. 

Model inputs are provided in Table 2, following the 
intuitive order used by PMWIN, in which model inputs 
follow the structure of the menu headings (File, Grid, 
Parameters, Models, Tools, Help). The demonstration 
neglects the slight error introduced by loading Field 
Generator results, which assume stationary block-block 

Y

Menu Option 
Input Value 

Demonstration Homework 
Grid → Mesh Size (1st time) 37 columns, 37 rows, size 5x5 m 52 columns, 27 rows, size 2x2 m 
Grid → Mesh Size (2nd time) use CTRL-arrow keys to subdivide 

cell (19,19) twice in x- and y-
directions 

(not required) 

Grid → Layer Type confined unconfined 
Grid → Boundary Condition → 
IBOUND 

constant head (-1) at left, no flow (0) 
otherwise 

constant head (-1) at left and right, 
no flow (0) otherwise 

Grid → Top of Layers reset matrix to 20 m reset matrix to 5 m 
Grid → Bottom of Layers reset matrix to 0 m reset matrix to 0 m 
Parameters → Time 1 period, active, length 1, unit days, 

steady-state 
1 period, active, length 1, unit days, 
steady-state 

Parameters → Initial Hydraulic 
Head 

reset matrix to 40 m reset matrix to 3 m, then manually 
set 3.17 m at left and 2.83 m at right 

Parameters → Horizontal Hydraulic 
Conductivity 

reset matrix to 1 m/d reset matrix to 8.64 m/d 

Parameters → Effective Porosity reset matrix to 0.25 reset matrix to 0.33 
Models → Modflow → Well set recharge in cell (20,20) to 

-295 m3/d 
(not required) 

Models → Modflow run run 
Models → PMPATH prepare output graphics (described 

in the main text) 
prepare output graphics (described 
in the main text) 

→ this completes the deterministic simulation 
Tools → Field Generator Accept default file name ―field‖ with 

no extension. Make 3 realizations 
with mean value 0, standard 
deviation 1, correlation length/field 
width 0.054 in the i- and j-directions, 
and number of cells 39 in the i- and j-
directions. 

Accept default file name ―field‖ with 
no extension. Make 3 realizations 
with mean value 0.937, standard 
deviation 1, correlation length/field 
width 0.20 in i-direction and 0.10 in 
j-direction, number of cells 27 in 
i-direction and 52 in j-direction. 

Parameters → Horizontal Hydraulic 
Conductivity 

load file ―field.1‖ load file ―field.1‖ 

Models → Modflow run run model 
Models → PMPATH prepare output graphics (described 

in the main text) 
prepare output graphics (described 
in the main text) 

→ this completes the first stochastic realization 

 

TABLE 2. PMWIN 5.3 MODEL INPUTS FOR THE GUIDED COMPUTER EXERCISE AND HOMEWORK  
ASSIGNMENTS  
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correlation, into a PMWIN model with non-uniform grid 
blocks. Experience has shown the following tips to be 
useful: 
 

 The path and filename together must be less than 
120 characters including spaces. 

 
 After setting the mesh size, use Options → 

Environment to reset X2 and Y2 in order to make the 
model fill the screen for easier visualization. 

 
 To assign a single value to every grid block, use 

Value → Reset Matrix. 
 

 Output graphics were prepared using PMPATH as 
follows: Drag a small square to select the cell 
containing the extraction well, then set Ni = Nj = 3 
and Nk = 1. Next, choose Options → Environment. 
On the Cross Sections tab, uncheck visible. On the 
Contours tab, check visible, then click on Level, set 
the minimum to 20 m, the maximum to 40 m, and 
the contour interval to 2 m. Click on Label Height to 
set it to 3 m. Click on Label Spacing to set it to 50 m. 
Click on Label Format, check fixed, set the decimal 
digits to zero, and the suffix to ― m‖. Close the 
Environment screen, then click ◄ to trace particles 
from the well back to the lake. Finally, choose File 
→ Save Plot As to output a bitmap file. 

 
 When entering data into the Field Generator, using 

5 m cells, the Field Width is 37(5 m) = 185 m. Given 
the correlation length of 10 m, the correlation length 
per field width is (10 m)/(185 m) = 0.054 in both 
directions. 

 
 After generating three realizations of hydraulic 

conductivity, check at least one realization to 
confirm  and sY using Microsoft Excel or 
equivalent. To perform this check, import ―field.1‖ 
into Excel, convert from K to Y using the =log10() 
function, and then confirm  and sY using the 
functions =average() and =stdev(), respectively. 

 
The results of this exercise, shown in Figures 1-3, 

provide an immediate stage on which to dramatize the 
qualitative difference between deterministic and 
stochastic models. In some respects, the results are similar 
for both approaches: The water flows from the lake to the 
well, with hydraulic head contours perpendicular to the 
streamlines, which converge at the well, where the 
hydraulic head is minimum and the drawdown is 
maximum. Clearly, the deterministic model does capture 
these aspects of the flow. However, the stochastic 
realizations make it clear that the deterministic model is a 
simplification, particularly with regard to two key points. 
First, the stochastic realizations illustrate more realistic 
flows—asymmetrical and non-uniform. Second, the 
qualitative differences between realizations visually 
demonstrate the concept of uncertainty. For most 
students, grasping the concept of uncertainty in 
groundwater modeling will be facilitated by comparing 

Figures 2 and 3. Then, armed with a conceptual 
understanding of modeling uncertainty and its geologic 
origin, the student will be prepared to learn quantitative 
expressions of this uncertainty, such as calculating the 
standard deviation of the design variable of interest after a 
full Monte Carlo simulation. Comparing Figures 2 and 3 is 
certainly less work. Importantly, since the student will 
have just created these figures personally, their impact 
will be deeper than identical figures illustrated in a text. It 
is also possible to analyze the results of these realizations 
quantitatively (See Discussion Section). 
 
Homework Assignment 

After the reading assignment, class presentation, and 
guided computer exercise, the students complete a 
homework assignment based on their previous PMWIN-
based solution to Problem 10‑17 in Fitts (2002). The 
problem statement is shown in the Appendix; model 
inputs are shown in Table 2; results are shown in Figures 4
-6. To complete the assignment, students apply 
knowledge from the reading assignment, class 
presentation, and guided computer exercise to a new 
problem, using their textbook, class notes, and the PMWIN 
manual, but without the benefit of step-by-step guidance 
from the instructor. As such, the assignment reinforces the 
learning objectives, in particular by asking each student to 
evaluate the relative merits of the deterministic and 
stochastic groundwater models. 

 

ASSESSMENT 
This one-week module has been included in the 

University of Colorado Denver’s graduate course 
Groundwater Hydrology since 2006. Two approaches 
have been used to assess its instructional effectiveness. 
First, submitted homework assignments (see Appendix) 
demonstrate that students were able to transfer skills from 
the module to a new application. Specifically, homework 
grades for the module-based assignment were analyzed 
and compared to homework grades for the remainder of 
Groundwater Hydrology, with details provided in the 
electronic supplement. For the module-based assignment, 
submission rates and mean grades for submitted 
assignments, respectively, were 79% and B+ in 2006; 75% 
and A- in 2007; 100% and A- in 2008. These grades are not 
significantly different from the mean homework grades 
for the remainder of Groundwater Hydrology. Since the 
homework assignment addresses objectives 3 and 4, 
corresponding to cognitive levels 3—Apply and 6—
Evaluate from Bloom’s Taxonomy (Table 1), the fact that 
the majority of students were able to complete the 
assignment supports the instructional effectiveness of the 
one-week module. 

Second, students of Groundwater Hydrology between 
2006 and 2008 were asked to complete a voluntary self-
assessment survey, which was reviewed by the 
university’s Human Subjects Research Committee, and 
which is included in the electronic supplement. The 
course rosters and admission files for the 33 students in 
this time period indicate that the student population 
included 24 men and 9 women; 27 Caucasians, 4 Asians 
and 2 Hispanics; 29 domestic students and 4 international 
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students; 28 graduate students, 2 undergraduates, and 3 
non-degree students; 28 civil engineering students, 2 
environmental science students and 3 non-degree 
students. Their ages at the time of enrollment ranged from 
23 to 48 years, with a median age of 31. Most of the 
students were employed as engineering or environmental 
professionals, and some had prior experience with 

hydrologic modeling. These demographic data do not 
allow us to identify possible correlations with the survey 
results, simply because the survey did not request 
demographic data. This was a deliberate choice, since the 
survey was designed to keep students anonymous, which 
was required for the survey to be approved by the 
university’s Human Subjects Research Committee. The 
need to avoid collecting demographic data on the surveys, 
in turn, was driven by the small class sizes (14 students in 
2006, 8 students in 2007, 11 students in 2008). With classes 
of this size, knowing that a survey respondent is—for 
example—female and undergraduate could be sufficient 
to uniquely identify the student, or at least to narrow the 
list down to a small subset of people. The reported 
demographic data was extracted from the course rosters 
and from information contained in the student’s 
admission files, so it should be considered reliable, but 
simply uncorrelated with the assessment survey results. 

In the survey, students were asked to rate the degree 

FIGURE 1. PMWIN output for the deterministic solution 
in the guided computer exercise.  

 
 FIGURE 2. PMWIN output for stochastic realization #1 
in the guided computer exercise.  

 
 FIGURE 3. PMWIN output for stochastic realization #2 
in the guided computer exercise.  

 
 FIGURE 4. PMWIN output for the deterministic solution 

in the homework exercise.  
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to which they agreed or disagreed with the four 
statements in Table 3, which mirror the educational 
objectives in Table 1, both before and after the one-week 
module. Students were also invited to provide comments 
or suggestions about the one-week module. Students from 
2006 and 2007 were contacted by an individual e-mail sent 
to their official university address, with a carbon copy to 
an alternative address, if available. All subjects replied by 
e-mail, although they were given the option of returning 
their survey by fax or postal mail. Students from 2008 
were provided a hard copy of the survey on the last day of 
class. The response rate was 8 of 14 students for 2006 
(57%), 5 of 8 students for 2008 (63%), 8 of 11 students for 
2008 (73%), and 20 of 33 students overall (61%). Because 
the survey was conducted after the course was over, 
students completed both the before and after assessments 
at the same time, so the survey effectively measured the 
perceived change in agreement with each statement. 

Results were interpreted using a 5-point Likert scale. 
The standard error for each question is the standard 
deviation divided by the square root of the number of 
responses. A statistical test was performed to determine 
whether there was significant change in the self-assessed 
agreement with each statement in Table 3, and this test 
was repeated for each class and for all three classes pooled 
together. The p-values were determined with the exact 
Wilcoxon signed rank test, using the statistics software R 
2.7.1 (R Development Core Team, 2008). The Wilcoxon test 

is a non-parametric alternative to the t-test that is 
appropriate in this case because the data are ordinal and 
the sample sizes are small (Clason and Dormody, 1994). 

 

DISCUSSION 
When interpreting the survey results, one should bear 

in mind that a self-assessment such as this measures 
student perception, which is not equivalent to 
instructional effectiveness. However, some discussion of 
the survey results is merited, because the literature does 
suggest that student perception is correlated with 
instructional effectiveness (Felder, 1992; Lowman, 1995). 
As shown on Table 3, there is a significant improvement 
(p ≤ 1.5x10-5) for statements 1-3 when results are pooled. 
When specific years are considered individually, the 
sample sizes are smaller, and consequently the p‑values 
are larger, indicating a smaller degree of significance. 
There was no significant change for statement 4, which 
asked students to critique standard deterministic 
groundwater models, and for which a decline had been 
expected. The lack of a significant change for statement 4 
could indicate that the phrase ―accurately represent flow‖ 
was ambiguous, or may indicate the need to articulate the 
limitations inherent in deterministic groundwater models 
more clearly in future years. On the whole, the assessment 
survey indicates that the students self-reported significant 
improvement in their ability to perform three of the four 
educational objectives in Table 1. Taken together, the  

 
FIGURE 5. PMWIN output for stochastic realization #1 in 
the homework exercise.  

 
 FIGURE 6. PMWIN output for stochastic realization #2 

in the homework exercise.  

Statement 2006 2007 2008 Pooled 
1. I can define the term stochastic. 1.4±0.5¹ 

p = 0.063 
1.6±0.6 
p = 0.13 

2.4±0.3 
p = 0.0078 

1.9±0.3 
p = 1.5x10-5 

2. I can explain the concept of spatial correlation for 
hydraulic conductivity (or home values). 

1.9±0.3¹ 
p = 0.016 

2.0±0.6 
p = 0.13 

1.9±0.2 
p = 0.0078 

1.9±0.2 
p = 3.8x10-6 

3. I can use software, such as MODFLOW, to simulate flow in 
heterogeneous aquifers. 

2.7±0.3¹ 
p = 0.016 

3.0±0.4 
p = 0.063 

2.2±0.4² 
p = 0.016 

2.6±0.2 
p = 3.8x10-6 

4. Standard (deterministic) groundwater models accurately 
represent flow in aquifers. 

-0.4±0.6¹ 
p = 0.69 

-0.2±0.4 
p = 1.0 

-0.1±0.6 
p = 1.0 

-0.3±0.3 
p = 0.46 

 

¹ Omits one student who checked only before, not after. 
² The response from one student who checked Neutral and Agree was averaged. 
*The Likert scale was 1 = Strongly Disagree; 2 = Disagree; 3 = Neutral; 4 = Agree; 5 = Strongly Agree, so larger numbers indicate greater agreement 
with each statement after completion of the one-week module. The exact Wilcoxon signed rank test was used to calculate p-values. Raw data are avail-
able in the electronic supplement.  

TABLE 3: ASSESSMENT SURVEY RESULTS, EXPRESSED AS THE MEAN DIFFERENCE BETWEEN SELF-
ASSESSED BEFORE AND AFTER RESPONSES, PLUS OR MINUS ONE STANDARD ERROR*.  
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homework performance and the survey results suggest 
that the module was effective. 

Of the 21 surveys returned, 11 had written comments 
(52%). Of these, 7 were positive and 4 were neutral, 
containing both positive and negative comments. Several 
of these comments indicate the one-week module was 
effective: 
 

 ―The software demonstration was most helpful for 
me. To run the model with [the instructor] and have 
questions answered on the spot aided my success in 
[the homework] and understanding of the 
groundwater model.‖ 

 
 ―It is good to show the different paths that occurred 

in MODFLOW since they are both viable alternatives 
that still meet the parameters.‖ 

 
 ―I think the one week module was well worth the 

time… From my experience I have noticed that 
stochastic modeling is less applied in practice. 
Through the one week module I am more apt to 
consider such modeling practice or at a minimum 
mention that there are more solutions available in a 
problem [than] the solutions presented with 
deterministic modeling schemes.‖ 

 
Among the negative comments, one concern was that 

this one-week module was ―a tad bit rushed,‖ which was 
also reflected by another student who felt that the exercise 
―was insufficient in length to allow students to become 
comfortable or competent with the modeling process.‖ 
Another comment suggested the assignment could have 
been more ambitious, writing that ―perhaps a critical 
thinking application could also be added.‖  

Along these lines, a number of extensions could easily 
be added. One option would be to have each student 
create not just three realizations, but three times the 
number of students in the class. By assigning unique 
simulation numbers to each student (e.g., 1-3 to student 
#1, 3-6 to student #2, and so on), a large number of 
realizations could be performed without requiring any 
one student to perform more than three. Then, each 
student could report back three values of a selected model 
output. For example, the deterministic model output 
(Figure 1) indicates that the hydraulic head at the well is 
in the range of 24‑26 m, while the first stochastic 
realization (Figure 2) indicates 18‑20 m, and the second 
realization (Figure 3) indicates 26‑28 m. The instructor, or 
a teaching assistant, could then assemble the results into a 
histogram to be presented at a subsequent class meeting. 
A second option would be to proceed along the lines of 
Section 6.7.2 in Chiang and Kinzelbach (1998), 
corresponding to Section 5.6.2 in Chiang (2005), who 
calculated the proportion of a contaminated area that 
would be captured by a certain extraction well, first in a 
given realization, and then in a suite of realizations. 
Again, this could be explored through a coordinated effort 
by the entire class. 
 

 

CONCLUSION 
When a panel of experts was asked ―What must be 

done in order to render stochastic theories and approaches 
as routine tools in hydrogeologic investigation and 
modeling?‖ one response included a call to action: ―The 
schools must acknowledge the fundamental nature of 
uncertainty in hydrogeology by teaching stochastic 
modeling. A subject must be taught if it is to have much 
impact‖ (Winter, 2004). The one-week module described 
above partially addresses this concern by providing a brief 
introduction to stochastic groundwater modeling, with 
student involvement in the classroom and in the computer 
laboratory, whose instructional effectiveness has been 
assessed through submitted homework assignments and a 
self-assessment survey. While these exercises are no 
substitute for a formal course in stochastic groundwater 
modeling, it is hoped that students who complete this 
module at the end of a first course in groundwater will be 
more likely to take a second course, and that students who 
complete this module at the beginning of a second course 
will be motivated and excited, having gained some insight 
into stochastic groundwater modeling before diving in to 
the rigorous methods provided in textbooks by Zhang 
(2002) or Rubin (2003). And, even if students never 
generate another random field, it is hoped this one-week 
module will help them gain a more mature appreciation 
for the limitations inherent in the deterministic 
groundwater models that continue to be the bread and 
butter of groundwater consulting practice. 
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APPENDIX: HOMEWORK ASSIGNMENT ON 
STOCHASTIC GROUNDWATER MODELING 
 

Simulate a 100x50 m unconfined sand aquifer, with 
constant head boundary conditions of 3.17 m upstream 
and 2.83 m downstream and no-flow boundary conditions 
along the 100 m edges. Assume an average hydraulic 
conductivity of K = 8.64 m/d. Use grid blocks 2 m square. 
 

(a) Assume homogeneous hydraulic conductivity, 
then run MODFLOW. Inside PMPATH, highlight cell 
(3,14), then use the ―Particles in Cells‖ box to enter 
Ni = Nj = 3 and Nk = 1. Then choose Tools → 
Presentation → Options→ Environment → Contours, 
then double-click on the Level heading to specify head 
lines every 0.05 m from 2.80 to 3.20 m. Finally, click on 
the ► button to show streamlines. Your results should 
show parallel potential lines with perpendicular 
streamlines. Choose File→Save Plot As to export your 
results to Microsoft Word or equivalent. 
 
(b) What average Y=log10(K) is equivalent to 8.64m/d? 
 
(c) Assume the standard deviation of Y is 1.0 log unit, 
and that the spatial correlation length is 10 m. What is 
the correlation length per field width in the i-direction 
and j-direction? Note, the i‑direction corresponds to 
rows, and the j-direction corresponds to columns. 
 
(d) Use the Field Generator to generate three possible 
realizations of hydraulic conductivity. Import your 
first realization into Microsoft Excel or equivalent, and 
confirm that the average Y and the standard deviation 
of Y are correct. Note, the average simulated K will not 
be 8.64 m/d. 
 
(e) Inside PMWIN, change the horizontal hydraulic 
conductivity, rerun MODFLOW, and then use PMPATH 
to track particles. Submit a plot showing head lines 
and streamlines for each of three realizations. Based 
on your results, briefly evaluate the relative merits of 
the deterministic and stochastic models.  


